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On the associated DVD within the folder called Demo_movie_clips is a series of short 
Quicktime movies that will show you each demonstration and tutorial described in the 
text. You will need Quicktime 7 player installed on your computer to view these movies. 

The player is available to download for free from Apple (www.apple.com/quicktime/download/). 
Where you see the Quicktime movie logo in the text  there is an associated movie clip (Quicktime 
logo is copyright of Apple).  
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1.0 Introduction and objectives 
 

Digital photography has exploded in the past few years as consumers and many professional 
photographers switch from shooting film to digital. Digital technology is now capable of achieving 
results superior to images produced on small format film. 
 
Advantages of digital cameras include:  
 

1) No cost to shoot as many frames as you like. 
2) Immediate preview of the image on the camera LCD monitor. 
3) Wider dynamic range resulting in better shadow detail and better tonal range. 
4) Lower noise and grain at high ISO speeds.  
5) Ability to change the camera ISO setting on the fly as light changes. 
6) Ability to shoot thousands of images on a single memory card with no 36-frame limit.  
7) Ability to change white balance and exposure after taking your picture using software. 
8) Ability to email your files or put them on the Internet. 
9) Digital files have greater stability then film and are insensitive to airport X-rays. 

 
Disadvantages of shooting digital include:  
 

1) Larger number of camera features resulting in greater complexity. 
2) Camera manuals can exceed hundreds of pages.  
3) Digital cameras depreciate quickly as newer and better models appear.  
4) Digital cameras are totally dependent on electrical power.  
5) Best image results are obtained after processing in an image editing program.  
 

Although digital cameras tend to be more complex then their film counterparts, the ability to view 
an image immediately after shooting and the zero cost of digital images means photographers 
can learn and improve faster then those shooting on film. I believe those photographers 
determined to stay with film do so either because they don’t wish to spend the money to upgrade, 
don’t use or want to use a computer and\or do not fully realize the benefits of digital photography. 
I have used film for over 30 years and there is no doubt in my mind that digital technology is 
superior to film in most circumstances. The only exception I am aware of where film might still be 
better is for long exposures at night used to create star trails or when there is a requirement to 
shoot without battery power.  
 
For photographers that have decided to shoot digital images one of the first decisions will be what 
file format to record their images on, assuming their cameras give them several choices. Better 
cameras will offer a choice of shooting JPG, TIF and RAW files. JPG or JPEG stands for Joint 
Photographic Experts Group and refers to compressed images. Some cameras permit shooting 
both JPG and RAW files at the same time. There are advantages and disadvantages to each of 
these file formats. In short, JPG files are compact and will you allow you to shoot the greatest 
number of images, but at the expense of lower quality and less flexibility. RAW files are larger 
files, require post processing, but permit the photographer to enlarge the image, and alter 
exposure and white balance afterwards. RAW files provide maximum quality and flexibility, but at 
the expense that each image must be processed in appropriate software. I shoot RAW format 
most of the time and only switch to JPG files when shooting time-lapse photography. TIF files or 
Tagged Image Format is the best file format to archive your digital files or make prints from.  
 
No matter what type of images you shoot, in this workshop you will learn how to calibrate your 
monitor, set up Adobe Photoshop so it uses colour profiles to achieve consistent results, and you 
will learn the steps (workflow) required to create colour corrected images. In addition you will 
learn how to convert your colour images to black and white, sepia, make a black and white image 
leaving behind some colour, extract an image, blend images into a panorama, and fix a variety of 
defects such as red eye, dust spots, crooked horizons and more. In short, you will be introduced 
to the power of Adobe Photoshop and what it can do to make your images better and have some 
fun doing it.  
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2.0 Components of a Digital Darkroom  
 
The components that make up a digital darkroom include:  
 

1) A computer, monitor, printer, scanner, and a digital camera.  
2) Image editing software e.g. Photoshop, Elements, GIMP, Picasa etc.  
3) Electricity – its tough to set up a digital darkroom in the wilderness. 
4) Internet access for tutorials, downloading software, and to share your images. 

 
2.1 Computer minimum requirements to run Photoshop CS4 are:  
 
1 Ghz processor  
1 GB of RAM  
1GB of available hard drive space for installation;  
1024×768 display with 16-bit video card (24 bit is better permits more colours to be viewed) 
An external hard drive to back up your images - 2 hard drives if the images are valuable.   
 
These are minimum requirements, given the low cost of RAM I would recommend 3 GB of RAM 
or more if you can afford it, and a video card that has at least 256 MB of RAM so you can set it to 
display 24 bit colour (16.7 million colours).  
 
Buy the best quality monitor you can afford. Older cathode ray (CRT) television style monitors are  
difficult to find so you will most likely be looking at purchasing an LCD (liquid crystal display) flat 
panel monitor. Which ever monitor you buy look for a monitor that has brightness and contrast 
controls. Also avoid monitors with high gloss screens if possible and opt for the matte screen 
option. If possible view some pictures on the monitor before purchasing it – also read reviews on 
the web.  After the purchase of your camera, your monitor is one of the most important items as 
you will be making decisions about your pictures based on what you see on it – so don’t go with 
the cheapest. If you plan to do a lot editing in front of your monitor buy the biggest monitor you 
can afford. Other monitor factors to consider are the brightness, scanning frequency and optimum 
viewing angle.  
 
Mac versus PC. For many folks it will come down to a personal decision or financial one. The 
best advice I have heard is to buy whatever your friends have as no matter what computer you 
use you will need help from time to time. Photoshop is available for both systems. The 
instructions in this workshop are for PC, if you use a Mac substitute the Ctrl key for Cmd and Alt 
key for Opt key and you should have no problem following these tutorials.  
 
2.2 Image Editing Software What you purchase and use will depend on how much control you 
wish to have over the image editing process, how much time you are willing to invest learning the 
software and what you can afford to pay. Photoshop is simply the best there is right now, it is 
used widely in photography, graphic design, and in the movie industry.  There are also a wide 
range of learning resources, including courses, books and videos to help you learn Photoshop.  If 
you take your photography seriously, then Photoshop is the most powerful image editing program 
available. It will take years to master this program, but the good news is that in this one day 
workshop you will learn the most important features required by photographers to make good 
images look great. 
 
A selection of image editing programs include:    
 

1) Adobe Photoshop CS4 – powerful, expensive and steep learning curve. 
2) Adobe Photoshop Elements – adequate for most amateurs needs. 
3) GIMP – free and available for Mac, PC and Unix computers. 
4) Nikon Capture software –adequate for some users.  
5) Adobe Lightroom – gaining popularity, but limited features compared to Photoshop. 
6) Picasa  - free and available for both Mac and PC, limited image editing features. 
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Adobe Elements offers many features found in the full version of Photoshop, and offers more 
extensive help menus and is easier to learn – for some photographers this may be all they ever 
need.  Most of the techniques learned in this workshop can be applied to Elements though the 
location of the menus will be different. Another excellent image editing program is GIMP and it is 
totally free. GIMP stands for General image manipulation program and has been under 
development since 1995 and although it is not as feature rich as Photoshop it supports RAW files 
and is the best free image editing program available. Adobe Lightroom has also been gaining in 
popularity because it is cheaper and easier to learn then Photoshop. Lightroom however, does 
not offer any significant advantages over the full version of Photoshop other then lower cost and I 
have found it very limiting in terms of what I believe serious photographers require, but not all 
photographers agree with me.   
 
Picasa is a free program available from Google that serves as a simple image editing program 
and a powerful image database. It is available for PC and Mac. Picasa will find the images on 
your hard drive and display them including your RAW files, movies and other graphic files. It can 
also be use to create screensavers, collages, and even movies. It is a must have program for any 
photographer and it's free. I use it’s image database capability frequently to locate images on my 
hard drive and present slide shows.  
  
 
2.3 Printers.  
 
Choosing a colour printer is a bit like choosing a camera, everyone has their favorites. I find the 
Epson colour printers to offer the best quality and value.  Epson also offers the widest range of 
paper types. Epson was the first to produce a printer with archive quality inks lasting more then 
50 years, an important feature if you wish to sell your prints as art. Canon, Kodak and others also 
make excellent printers. My advice is to go to a shop that sells printers and that can show you 
sample prints from each printer. Note if you plan on printing black and white – look for printers 
that offer separate ink cartridges and ones that have black and gray – the more black tones your 
printer has the better your black and white pictures will look. 

 
  
2.4 Scanners  
 
If you own negatives, slides or prints and you want to digitize them you will need a scanner. Flat 
bed scanners can be purchased for about $100-600. Some flatbed scanners also scan negatives 
and slides. If you own thousands of slides then investing in a slide scanner is a good idea. If you  
only shoot with a digital camera then I would recommend investing in an all purpose scanner that 
scans prints, slides and negatives. Things to look for in a quality scanner are bit depth (24 bits 
colour or greater), dynamic range 3.6 to 4.2 is the best available. In slide scanners look for dust 
removal features and multi-scanning capabilities. Multi-scanning is particularly useful for slides 
with large dark areas which tend have a lot of digital noise. Multi-scanning is a feature that scans 
the slide several times and averages the data resulting in lower digital noise. If you have a lot of 
slides or negatives to scan also look for a scanner that can scan a large file quickly (90 seconds 
or less) or you will be sitting in front of your scanner for days! I would recommend looking at the 
Nikon or Canon slide scanners. For flatbed scanners I recommend looking at the Epson 
Perfection photo line.   
 
 
2.5 Colour Management  
 
The main goal in printing your images on an inkjet or dye sub printer is to achieve prints that 
come as close as possible to the images we see on our computer screen. In order to achieve this 
we need to calibrate the monitor and use a colour management system. Adobe Photoshop can 
be your colour management system. Keep in mind that images on paper can never be as brilliant 
or saturated as those we see on a monitor or a slide because transmitted light will always appear 
more brilliant then reflected light.  
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Additive colours Red, Green and Blue are used on computer monitors to produce the array of 
colours we see, subtractive colours are used when printing and are referred to as CYMK for 
Cyan, Yellow, Magenta and Black. The range of colours in RGB and CYMK modes are slightly 
different and colour on prints cannot appear as pure or saturated as those on a monitor or slide.  
 
2.6 Colour Space 
 
In order to work with colour and produce consistent results scientists have developed models to 
describe and quantify colour. A colour space is simply a model that describes the various colours 
that can be seen or produced by a particular device such as a camera, monitor or printer. The 
LAB colour space represents the largest range of colours that the average human eye can see 
and all other colour spaces are smaller and fit inside this one (see below).   
 

 
 
 

The Adobe RGB colour space is smaller then LAB and both the sRGB and CYMK colour spaces 
are smaller then the Adobe RGB space. The smaller the space the fewer colours that are 
contained. One of the main problems with producing consistent colour when using digital devices 
is that each device has a unique range of colours it can produce called a colour gamut. As we 
move the image from one device to another the colour gamut usually gets smaller and some 
colours may not exist in the new device e.g. printer. By creating a colour profile that describes the 
range of colours a device can reproduce, converting images from one device to another using a 
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colour management system (Adobe Photoshop) it possible to get more consistent and predictable 
colour and that is what colour management is all about. 
 
The computer monitor is the most important component in the chain of your digital 
workflow. Therefore you only need to calibrate and profile your monitor in order to 
produce consistent and predictable results.  
  
3.0 Calibrating your Monitor 
 
Monitors come in two basic types, cathode ray tube or CRT and liquid crystal display or LCD.  
Some experts claim that CRT monitors are better for critical colour correction work and they are 
easier to calibrate – this may be true, but the reality is that CRT monitors are being replaced by 
LCD screens that are lighter in weight, cheaper to manufacture and draw less power. LCD 
monitors have improved greatly in quality and features and many professionals are using them 
with good results. If you are doing critical colour correction work avoid the LCD monitors with 
shiny screens and instead go with a matte screen surface. Also look for monitors that offer 
brightness, contrast and or white balance controls. Do not buy the cheapest monitor you can find. 
Laptop monitors are generally more difficult to calibrate and some of them frankly can’t be 
calibrated. I will show you in this workshop how to colour correct images whether or not your 
monitor has been calibrated, however in order for your monitor to accurately represent images 
that you print you will need to produce a monitor profile and configure Photoshop to use the 
profile. Since CRT monitors are disappearing I will focus on procedures to calibrate LCD monitors 
only in this workshop.  
  
3.1  Room Lighting  
 
The placement of you monitor with respect to other room lights and the overall room lighting 
conditions are very important. Don’t put your computer monitor near large windows, or directly 
underneath a bright light. If you do have your computer in front of a large window then make sure 
you have blinds or drapes that allow you to darken the room when you are doing colour correction 
and other image editing procedures. Generally speaking, rooms with low light levels are best for 
image editing. If the lighting where you computer is stationed changes drastically then this may 
make it more difficult to achieve consistent results. The light source that you evaluate your prints 
is also important, Epson recommends using a tungsten light, other printer manufacturers may 
recommend using a daylight bulb (5500 to 6500 K). 
 
3.2  Colour Spectrophotometer and Software  
 
The best way to calibrate you monitor is to use a combination software and hardware device 
(spectrophotometer) sometimes referred to as a colour spyder. There are number of products 
now available in the $100-$300 range that do a pretty good job. Colour spyders are available at 
most professional camera stores and camera departments. I have used a couple of different ones 
and the one I am currently using is the Spyder 3 pro. Basically you install the software on the CD 
included, plug in your spyder to the USB port start the software and follow the instructions. The 
process takes about 5-10 minutes and when you are done you save the colour profile created 
onto your computer. The final step is to configure Photoshop to use the monitor profile you 
created. How often you calibrate will vary – I generally recalibrate every few months. The 
software also can be installed on several computers so you only need one kit to calibrate all the 
computers you may own.  
 
Two things you need to know when using this software is what to set the white point to and what 
to set the gamma. Basically – set white point to 6500 K – colour of your whites and set your 
monitor gamma to 2.2. You may also be prompted to change your computer monitors contrast 
and brightness setting – follow the instructions you software provides. When you are done save 
the colour profile – I like to include my name and date e.g. rberdanNov22.icm. This profile will be 
saved as an .icm profile which is simply a text file that describes the characteristics of your 
monitor. Note if your colourimeter has a suction cup do not stick it on your LCD monitor or you 
could damage it – just hold the colourimeter with your hand or hang it in front of your monitor. I 
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will demonstrate this in the workshop. It is now recommended that the same settings should be 
used for both Mac or PC computers. Older Mac computers used a gamma setting of 1.8.   

 
 
monitor_calibration 

 
6.0 Photoshop CS4 Tutorials  
 
6.1 Open Image Files in Photoshop - there are three ways to do this.  1) File>open navigate to 
the folder with your images and select the image file,  This method works best when loading files 
from a CD or DVD and is fast. In the open box you can select to  view files as a list or thumbnails. 
 

 
  
2)  Select File>Browse in Bridge  - have Essentials selected at the top of Bridge. You will have 
to navigate to the folder with your images and then view the thumbnails in the main window - 
double click on an image file to open it in Photoshop. If you double click on a RAW file, it will first 
open in Adobe Camera RAW. You can also simply drag the files from Bridge into Photoshop. 
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You can also Launch Adobe Bridge by selecting the Launch Bridge Button at the top of 
Photoshop.  
 
 3) The third way to open files in Photoshop is to have Photoshop open, select your folder, 
open the folder then drag the image file into Photoshop i.e. Drag and drop into main window.  
 
If you don't see thumbnail views for your RAW files you may have to upgrade Photoshop to get 
the latest RAW converter - to do this select the Help menu at the top >Updates and Photoshop 
will check if there are any updates and if so it will download and install them. If you still don't see 
the RAW files you may need to call Adobe or uninstall and reinstall the program to fix the 
problem.  
 
Digital Workflow - we will start with a RAW file, adjust exposure, white balance, saturation, size 
and bit depth - then open the file in Photoshop and make further adjustments including colour 
correction, resize, burn, dodge, paint with the sponge tool, add a border and save it as .TIF file for 
printing.  If you are starting with a JPG or TIF file - the steps will essentially be the same once the 
file is open in Photoshop. 
 

 See openfilesCS4.mov 
 
6.2 RAW workflow 
 
Each camera manufacturer offers its own RAW file format and file extension. RAW files also differ 
even from the same manufacturer on different camera models. A few cameras can create a 
generic RAW format that Adobe promotes called a Digital Negative Format and it has the file 
extension .dng. You can convert any RAW format into .DNG format using Adobe Camera RAW 
by selecting Save Image in the lower left of the Adobe Camera Raw (ACR) window.  To find out 
what cameras are currently supported by ACR check out Adobe's web site: 
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http://www.adobe.com/products/Photoshop/cameraraw.html. (Note Adobe Lightroom uses the 
same ACR engine to open RAW files and also needs to be updated periodically).  
 
 
1. Select Adobe Bridge and navigate to the Photoshop tutorials folder and select the RAW folder.  
 
2. With the thumbnails displayed, select and double click on Morning.NEF a picture of Robert first 

thing in the morning with his Nikon Camera. Before we correct the white balance we will set the 
default ACR settings. At the bottom of the picture you can see a blue hyper link - click on it   
and ensure the settings are set to: Space: AdobeRGB (1988); Depth 16 bits; Size 12.2  MP - 
note you can select smaller or larger file sizes, even enlarge your image up to 25.1 MP with 
very little noticeable degradation.  Set Resolution to 300 ppi and leave the other settings at their 
default. If you want to enlarge your image or a component within your image you always have 
the option to increase the file size in ACR to a maximum of 25 MP.  

 

 
 
 
3. Above in ACR the picture is surrounded by a large number of controls on the right and at the 
    top. We will focus for now on the main controls needed to manipulate your image.   
 
4. Select the exposure slider and move it to the right or left and notice how you can change a 

pictures exposure. This is a very powerful feature, but if your picture is very overexposed with 
blown out highlights you may not be able to recover them. Move the exposure to about +1.0 
which is equivalent to 1 F-stop increase in exposure.  Because it is possible to alter exposure 
after taking a picture in RAW format there is no longer a need to bracket photo exposures -  
that is taking several shots increasing and decreasing the exposure as was often done when 
shooting slide film.  

 
5. Next we will fix the white balance or color cast. There are three ways to do this. A) Select 

White balance drop down menu on the right and select the different options e.g. Auto, daylight 
etc and note how  the white balance changes. The best result appears using "Auto" white 
balance. Leave the white balance at "As Shot" for now.  b) Select the Temperature slider and 
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move it to the right or left and note how the white balance changes. At 2650 the picture does 
not look bad but still has a yellow cast. You can adjust the Tint slider below to try and remove 
any additional color cast - try  setting Magenta to +12.  The best settings will vary depending on 
the monitor you use and your personal preference. C) Another method to adjust the white 
balance is to use the white balance tool - eyedropper just right of the hand at the top. Click on 
the image with this tool on an area that has 3\4 tone white - light area of the picture that should 
be neutral e.g. the wall - you will see the white balance change. By clicking on different colored 
areas of your image you can change the colour cast. You can also use the eyedropper tool with 
a cross in a circle right next to it - click on a neutral area of the picture and it will display the 
RGB values. If you have a neutral white or gray the RGB values should be approximately 
equal. This eliminates any "subjectivity".  

 
 

 
 

Above -select the white balance tool and click over an area that should be neutral like the wall to 
the right. Do not select very bright or very dark areas.  
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Click the eyedropper with cross above it over the wall and note the RGB numbers when they are 
all equal or very close  - as shown R 193, G 194, B 195 your picture should have a proper white 
balance. When you are done select>Open image.  From here you can make additional 
adjustments but we are going to work with some different RAW files - so close the file without 
saving.   
 
The RAW converter has so many features that there are entire books describing its' features.  
When you start out with ACR concentrate on the main controls before you begin to explore the 
more advanced features. In the workshop we will briefly look at some of the advanced features 
such as recovery, clarity, noise reduction, and fixing chromatic aberration. 
 

   See cameraraw1.move  
 
 
6.14 Blending photos to make a panorama 
 

 
 
Stitching images together to make panoramas has never been easier - you don't even need a 
tripod when you take the pictures though it will help. The two most important things you need to 
do is 1) lock the exposure so the exposure does not change as you pan your camera taking 
several pictures. You can switch your camera to manual mode or if your camera has a pan mode 
use it to lock the exposure while taking the series. 2) You need to have overlap between each 
picture about 20-30% of the frame works well. If you don't have enough overlap Photoshop will 
not be able to stitch the images. There are special tripod heads you can purchase if you would 
like to make panoramas frequently. For best results have your camera in the vertical position so 
your panoramas will be taller as shown above. You can use two or more images - so technically 
you always have the ability to create wide angle shots no matter what lens you have with you.  
 
1. Select File>Automate>Photomerge select Browse go to the folder called Kananaskis_pan and 
Shift-click on the images 01.jpg  to 08.jpg. In the layout menu select cylindrical - this option is best 
most of the time. You can experiment with the other modes on the same photo series. Click OK 
and watch Photoshop stitch your image together.  
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2. Open the layers palette you will see that each photo has been placed on its own layer and 
Photoshop created a mask to blend each photo. Select the top right of the layers palette to 
display the pop out menu and select flatten image to combine all the layers into one.  

 

 
 
3. The final step is to crop the image using either the crop tool or the marquee selection tool .  
 

 
 
4. If the image needs further adjustments or modification make them - then save the image for 

printing or the web.  
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Repeat the steps again and try blending three JPG files that were hand held - road01.JPG, 
road02.JPG and road03.JPG. Experiment with the different merge modes if you like.  
 
Another hint for taking panoramas is to try not to shoot directly into the sun - place the sun behind 
a tree or telephone pole. The best time of day to take panoramas is when the sun is overhead.  
Once in a while Photoshop is unsuccessful in stitching images together this usually occurs if there 
is not enough overlap between the pictures. The images can still be stitched together manually 
using masks - a technique I will describe in the Photoshop II workshop.  Finally in order to stitch a 
series of RAW files into a panorama your computer will need a lot of memory so either convert 
your images in JPG files before you stitch them or be prepared to buy more memory for your 
computer! 
 

 See panoramas.mov 
 
 
 
This contains only selected sections of the tutorials and manual to show you what the 
Notes look like.  The actual manual 67 pages in length and includes all the tutorials in the 
table of contents.  


